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Documentation Updates 

The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version.  

• Publish date, which changes each time the document is updated.  

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 
http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 

Note: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following web site:  
http://www.adobe.com/ 

http://h20230.www2.hp.com/selfsolve/manuals�
http://h20229.www2.hp.com/passport-registration.html�
http://www.adobe.com/�
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In This Version 

Service Manager Version 9.21, build XXX patch 4 (SM 9.21p4) includes several customer requested software 
enhancements and fixes. Refer to the sections below for information about the defects and enhancements for 
each release included in this cumulative patch. 

Service Manager 9.21 patch 4 updates the following areas: 

• Enhancements 

• Windows client updates 

• Web client updates 

• Server updates 

• Application updates 

• Documentation changes 

Enhancements 

The following enhancements are included in the current software release. 
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Global ID Module Problem  Solution  

QCCR1E64278 
QCCR1E64285 
QCCR1E64290 
QCCR1E67610 

Web client 
Windows client 
Server 
Applications 

Service Manager does 
not enable you to block 
executable files from 
being submitted as 
attachments.  

To prevent potentially dangerous executable 
files from being submitted as attachments, 
Service Manager now provides support for 
blocking certain types of attachments 
submitted through the Windows and web 
clients, as well as through web services, 
based on a pre-defined list of blocked file 
extensions.  
When users attempt to attach a file whose 
extension is in the list of blocked file 
extensions to a record, the clients disallow 
attaching the file and display an error 
message; when a web service transaction 
submits or retrieves a file as an attachment 
whose extension is included in this list, the 
server appends ".UNSAFE" to the submitted 
or retrieved file name. 
To take advantage of this enhancement, you 
must install all of the following: 

• The Windows client update for this 
release (QCCR1E64285) 

• The Web client update for this release 
(QCCR1E64278) 

• The server update for this release 
(QCCR1E64290), including the 
supporting application unload file, 
QCCR1E67610_SM921p4.unl.  

For more information see Additions to the 
Documentation. 

QCCR1E54726 Server Modify Login/Module 
license tracking in 
Horizontal Scaling to 
improve log-in 
performance and reduce 
jgroups traffic. 

Redesigned license tracking in Service 
Manager horizontally-scaled environments 
to reduce synchronous jgroups 
communication. 

QCCR1E62170 Documentation The Service Manager 
Web tier failed to 
connect to the server 
when deployed on 
WebSphere (WAS) 6.1. 

Users should follow the correct steps to 
deploy the Service Manager web tier on WAS 
6.1.  

For more information, see Additions to the 
Documentation. 
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Global ID Module Problem  Solution  

QCCR1E65574 Documentation The msglog:1 is not 
included in the Service 
Manager Help Server. 
This parameter has to 
be added in the sm.ini 
file in order to have the 
errors coming from the 
Web Client written into 
the sm.log file. Without 
this parameter, no error 
is written in the sm.log 
file. 
So the documentation 
needs to be updated 
with that parameter and 
with its explanations. 

Special parameter "msglog" is already 
documented in the Service Manager 9.2x 
Help Server.   

Added the following note to the parameter 
description:  

Note: If not explicitly specified (either in 
sm.ini or in the server's OS command 
prompt), this parameter is disabled.  

For the updated parameter description, see 
Additions to the Documentation. 

QCCR1E67744 Documentation The Service Manager 
documentation does not 
state that when 
integrating other 
applications with 
Service Manager 
through web services, 
array data should be 
broken into multi 
elements by separator 
"\r". Failure to do so 
could cause problems. 
For example, even if a 
configuration item (CI) 
is not changed, Service 
Manager always 
updates a change 
request, since the CI is 
stored in the Service 
Manager database as 
utf-8 while in UCMDB it 
is encoded as base64. 

Provided information on how to prepare 
array data when integrating other 
applications with Service Manager through 
web services.  
For more information see Additions to the 
documentation 

Web client updates  

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E54269 Web client hover form has a scroll bar, 
but it cannot be used because the hover 
form moves away from the mouse.  

The web client hover form will remain fixed 
and visible so that the scroll bar can be used.  

QCCR1E55847 Fields on the userrole.g form are not 
sized correctly in the web client.  

Changed the form style to properly 
accommodate the fields.  
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Global ID Problem Solution 

QCCR1E61753 Inconsistent behavior with the 
cursor.field.contents() functionality 
between the Windows and Web clients: If 
the reference from a table points to one 
line of an array, it will get all array 
values in the Web client while get only 
the value of that line in the Windows 
client.   

In the Web client, the cursor.field.contents() 
function now has the same behavior as the 
Windows client: If the reference from a table 
points to one line of an array, only the value of 
that line is referenced.  

QCCR1E61860 When Trusted Sign-On is enabled, the 
web client will always display in English 
even when passing in the lang=<lang> 
parameter, for example, 
index.do?lang=de. 

Language preference works normally when 
Trusted Sign-On is enabled for web clients.  

QCCR1E61919 After an upgrade, the Comfill fields 
retain the previously-selected value when 
a user clicks Fill.  

The Comfill fields no longer retain the 
previously-selected value when a user clicks 
Fill.  

QCCR1E62042 When using MySM and WebSphere 6.1, 
the user was redirected to goodbye.jsp 
and could not access the Web tier.  

MySM works properly in WebSphere 6.1.  

QCCR1E62847 When viewing a form 
(svcCat.Display.item) from "Order from 
Catalog" in Service Catalog, a multi-line 
text box does not align correctly in the 
web client.  

The dynamic form is now rendered as a two-
column 50/50 split layout: The multi-line text 
box spans two columns if the label is empty, 
while gets only half of the widget width if the 
label is not empty.  

QCCR1E63395 The "Quick Close" and "Submit" buttons 
are not displayed when a user opens an 
Employee Self Service (ESS) interaction 
for the first time with category RFA.  

The "Quick Close" and "Submit" buttons are 
now displayed, as expected, when a user opens 
an ESS interaction for the first time with 
category RFA.  

QCCR1E63974 Web Tier page display leaves the mouse 
pointer in a loading state (hour glass or 
spinning wheel, depending on the 
browser) until the mouse is moved. This 
causes users to think the list is still 
loading when it is not.  

The mouse pointer returns to the normal 
arrow, when the record set or page data is done 
loading.  

QCCR1E64121 Closing the Print window causes the web 
client to hang.  

Closing the Print window in the web client now 
returns the user to the record as expected. 

QCCR1E64480 Pressing the left arrow key returns the 
cursor to the last position of the field.  

Pressing the arrow key now moves the cursor 
to the expected position.  

QCCR1E64537 Read-only fields are displayed in gray 
text instead of black text when running a 
Web client with Internet Explorer 
versions 7 and 8. 
Here is an example scenario: 

1 Log in to the Windows client as a 
system administrator. 

2 In Format Control, open record 

Read-only fields are displayed in black text 
with a gray background.  
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Global ID Problem Solution 

"IM.update.incident". 

3 On the Calculations tab, add a new 
row with the following values:  

 initial: true 

 calculation: $atx.readonly.field=true 

4 In Forms Designer, open the 
IM.update.incident form in Design 
mode. 

5 On field "action" (label: Description), 
add this read-only condition: 
[$atx.readonly.field]=true 

6 Open the web client in Internet 
Explorer 7 or 8, and log in to the web 
client as a system administrator. 

7 Search and open an incident record 
with a read-only Description field. 
The Description field is displayed in 
grey text with a light gray 
background. 

QCCR1E64634 In the Web client, "Print Page" does not 
work properly for fields with a visible 
condition. These fields do not display in 
the print form when "Print Page" is 
clicked.  

Printing a page correctly displays fields with a 
visible condition.  

QCCR1E64720 The web client does not always prevent a 
user from performing a Fill against a 
read-only field. 
If the cursor defaults to a read-only field 
when rendering or displaying a record, 
the web client will allow a Fill if it is the 
first action performed on the screen.  

Fixed a problem in the web client that enabled 
users to fill read-only fields in some 
circumstances.  

QCCR1E65031 Print of a cm3r record may include fields 
with a Dynamic View Dependency  
(DVD) visible condition evaluating as 
false. 

Print of a cm3r record which includes a DVD-
visible condition will display correctly.  

QCCR1E65123 When performing routine tasks in the 
web client, the user can be unexpectedly 
logged out.  

The web client has been corrected to protect 
necessary session information to ensure the 
session is not terminated unexpectedly.  

QCCR1E65148 Text area fields with the read-only 
condition are not made editable 
dynamically in Firefox. 

For all supported browsers, text areas correctly 
toggle between read-only and editable, based 
on Dynamic View Dependency  (DVD)  
conditions.  

QCCR1E65315 When attempting to clear out the 
contents of a field that has a hover form 
configured and the delete key or 
backspace is pressed, the hover form may 

When users clear the contents of a field that 
has a hover form, the hover form no longer gets 
stuck. 
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Global ID Problem Solution 

get "stuck" and not go away. It then 
continues to display on the main ticket 
form and also on other forms, such as 
when filling in categorization values. 

QCCR1E65374 Using direct URL access to a specified 
incident does not work.  

Using direct URL access to a web page will 
open up the form with the specified Incident 
values filled in.  

QCCR1E65461 Following upgrade of the Web tier from 
7.11.281 to 9.21.113, attempts to access 
the Web tier via URLs generated from 
Service Manager 9.21.113 fail as hacking 
attempts. On reverting back to Service 
Manager 7.11.281, Web tier access via 
URLs is restored. 

Attempts to access the Web tier via URLs 
generated from Service Manager 9.21.113 are 
successful. 

QCCR1E65736 Web client sometimes fails to display the 
toolbar. 

Page is properly loaded only after all required 
content is available. The toolbar now works 
fine.  

QCCR1E65883 When a user connects to Service 
Manager through Trusted Sign-on (TSO) 
and the maximum number of concurrent 
logins is exceeded, there is no message 
sent to the user.  

When a user logs in through TSO and the 
maximum number of concurrent logins is 
exceeded, the following message is displayed: 
"Login failed. Maximum active logins for this 
user exceeded."  

QCCR1E66005 MySM page receives the following 
message, "The page cannot be displayed," 
in every small window using SSL 
configuration via Cisco ACE NLB.  

Changed the way MySM URLs are constructed 
to maintain protocol/host/port of the original 
request. This enables the pages to be displayed 
when using SSL configuration via Cisco ACE 
NLB.  

QCCR1E66617 After adding a line item to a new catalog 
item, the add dependency command link 
is missing. 

After adding a line item to a new catalog item, 
the add dependency command link displays. 

QCCR1E66835 Need an option to disable the log-in 
button in the Web tier after an operator 
clicks it one time. This will prevent 
issues when users get the message that 
they have reached the maximum number 
of sessions because they have clicked the 
log-in button multiple times.  

The log-in button is disabled when the log-in 
form is submitted by either clicking the button 
or pressing the enter key while the cursor is 
blinking in one of the input fields.  

QCCR1E67006 The Web tier infinitely sends the 
getLanguages SOAP request to the 
Service Manager server after the session 
is timed out in a particular environment, 
which causes the Service Manager server 
to stop responding.  

The user will be re-directed to the log-in page if 
the session times out. In some environments, 
this may re-direct to the log-out page instead.  

QCCR1E67134 When a Format Control validation fails 
on a field that is inside a collapsed group, 
the focus does not jump to that field.  

A group that contains a focused field is 
automatically expanded to show this field. 

QCCR1E67433 The Spell Checker of HTML Editor The Spell Checker of HTML Editor now opens 
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Global ID Problem Solution 

widget does not open when the user 
clicks the "Check Spelling" button.  

when the user clicks the button.  

QCCR1E67494 When there are two notebook tabs and 
the second one contains a Comfill field in 
a table column, the value of the Comfill 
column cannot be saved if the focus is 
moved to the first tab before saving. 

Value of the Comfill widget in a table can be 
saved when the focus is changed.  

QCCR1E67758 When searching for changes on Service 
Manager (SM) 9.21, fill-enabled data on 
the comfill object for fields like category 
and subcategory that are select only 
cannot be deleted on the web client. This 
problem started to occur when upgrading 
to SM 9.21 patch 3 of the web client. Web 
client patches 1 and 2 did not have this 
problem. 
 
If the user uses the fill option, chooses a 
value, and then realizes the chosen value 
was incorrect, highlighting the contents 
of the field to try to remove the value 
does not work. Pressing the backspace or 
delete keys does not work either.  

Users can remove the value even when the 
combo box is select only.  

QCCR1E67795 The record list sometimes fails to display 
in List Detail mode.  

The record list always displays in List Detail 
mode.  

QCCR1E68021 In the web client, Boolean values are set 
in one notebook tab and are not saved 
when focus is moved to another notebook 
tab.  
 
Note: This notebook tab is part of a sub-
group under a group.  

Boolean values are saved properly in the 
notebook tab when focus is moved to another 
notebook tab. 

QCCR1E68516 JavaScript files remain cached in user's 
browser, even when the user updates the 
web application.  

Changed the default max-age value of 'Cache-
Control' property of 'cacheFilter' bean from 
1296000 seconds to 28800 seconds to avoid 
some cache-caused issues.  
 
Important: Web user's browser cache will not 
automatically get refreshed after this value is 
changed and the web application server is 
restarted. For this reason, web users may have 
to manually clear their browser cache before 
logging in to the updated web client, as the 
user's cache may contain outdated web 
resources that are not expired based on the old 
max-age value.  

QCCR1E68704 The hover form in Service Manager 9.21 
P3 HF2 caused serious browser lockups 
and issues when it was used on an array 
field. Symptoms included delays in the 

The pop-up displays in a timely manner 
without an audible clicking noise.  
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Global ID Problem Solution 

pop-up being displayed, accompanied by 
an audible clicking noise.  

QCCR1E69005 Selecting a record in a recordlist caused 
the whole recordlist to refresh, which 
caused a performance issue.  

When a record is selected in a recordlist, the 
recordlist is not automatically refreshed.  

QCCR1E69216 The web browser hangs after navigating 
between queues. Often users will get the 
following message: "Internet Explorer 
Cannot display the web page." Users 
need to delete temporary files and 
cookies, and then restart Internet 
Explorer to get to a log-in page.  

The web client no longer produces errors or 
hangs when users navigate between queues.  

QCCR1E69476 In the web client, in the Approval Log 
section of Change Management, the 
comments column does not display input 
values after the first row. 

The comments column can display input values 
after the first row in the Approval Log section. 

QCCR1E69488 Multiple users are simultaneously 
disconnected from the Service Manager 
(SM) web client, and then directed to the 
"login again" page (session timeout). This 
creates multiple sessions, which are seen 
connecting back to SM although users 
have not logged in but instead left the 
browser on the "login again" screen.  

Multiple sessions are no longer created for 
clients when there are log-in problems.  

QCCR1E69868 On a search screen, if the user adds a 
Comfill whose value is "masked" using a 
value-display list and then selects a 
value and searches on it, no results are 
returned. The root cause is that the web 
tier sends the display value to the 
background, and saves this display value 
to the database. 

Fixed the issue by sending the correct data (the 
value list value) to the background so that the 
correct records are returned. 

QCCR1E69969 The Service Manager Tomcat instance 
has a large and increasing number of 
HTTP connections. Java monitoring data 
indicates that Service Manager creates 
over 500 HTTP connections. The Service 
Manager Web Tier thread dumps 
indicate that numerous threads are in a 
state of BLOCKED while waiting to 
acquire a monitor lock.  

Concurrency handling has been improved to 
avoid numerous threads being blocked during 
long-running queries.  



 11 

Windows client updates  

The following item (identified by reference number) is fixed in the current software release.  

Global ID Problem  Solution  

QCCR1E49051 The HTML Editor spell check 
replaces back slash with a square 
when correcting misspelled words.  

The HTML Editor spell check will now handle the 
backslash character correctly, and not remove 
backslashes from the text.  

QCCR1E60369 The Windows client crashes due to a 
memory leak when users view forms 
that contain a large number of 
Dynamic View Dependency (DVD) 
fields.  

The memory will be released, which will alleviate 
the errors that caused the crash.  

QCCR1E60834 After performing a binary upgrade 
on a Service Manager 7.02 system 
and bringing the system to Service 
Manager 9.20 patch level 1, a chart 
that was selected did not show the 
record list as expected. Instead, the 
Advanced search form was 
displayed.  

The record list is shown after selecting a chart.  
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Server updates  

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E31923 Client thread crashes when the data length 
exceeds the size defined in the database.  
The following is an example: 

1 Log in as a system administrator. 

2 Type "contacts" in the Service Manager 
command line, and then press Enter. 

3 Click Search. 

4 Take, for example, the first result: 
"BROWN, NICHOLAS". 

5 In the Contact Name field, change 
"BROWN, NICHOLAS" to "BROWN, 
PPPP...", which contains, for example,  
350 instances of letter P. 

6 Click Save 

An error message like this occurs: 
"Length (226 bytes) of data for 
field contact.name in contacts 
exceeds max (140 bytes), truncated 
(se.base.method,update.record)". 

7 Click OK. 

8 Log off, and then log back in as a 
system administrator. 

9 Type "contacts" in the command line, 
and then press Enter. 

10 Click Search. 

The error message "Panne SOAP: An 
exception was raised in native 
code : error Win32 EH Exception: 

0XC0000005. Client terminated." 
appears and the client session ends. 

When the data length exceeds the size 
defined in the database, the data 
truncation error message will still occur as 
expected, however the client will no longer 
crash. 
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Global ID Problem Solution 

QCCR1E32397 During table creation, specified table space 
parameters are not honored.  

1 Start Service Manager in single-user 
mode. 

2 Go to Tailoring > SQL Utilities > Move 
Files from SQL to SQL. 

3 On the Basic Options tab, in the "File 
to convert", select 
SYSATTACHMENTS. 

4 On the Advanced Options tab, set the 
new table space 
"SM7_ATTACHMENTS" in the 
following:  

—  Table Space Name  

—  Index Space Name  

— Lob Table Space Name  

— Lob Index Space Name 

5 In the Final Objective section, select 
Move Data. 

6 Click Proceed. 

During table creation, specified table space 
parameters will now be honored.  

QCCR1E49322 When using the dbdict utility to rename 
the SQL name of a field, it fails if the 
current SQL name is a reserved word in 
the database.  

The column names in the generated 
statement are enclosed between double 
quotes, which allows the SQL name of a 
field to become a reserved word.  

QCCR1E57650 When trying to modify the unique key of  
the contacts table, Service Manager 
displays errors.  

When trying to modify the unique key of a 
table with array tables or m2 table, a full-
table copy will now be invoked.  

QCCR1E58163 Service Manager (SM) background 
processes defined in the sm.cfg fail to start 
if their log path contains spaces.  

SM background processes defined in the 
sm.cfg file now start successfully even if 
their log path contains spaces.  

QCCR1E58648 When Service Manager acts as a web 
service client, the doSoapRequest methods 
may time out and generate error messages 
that are not easily understood in the server 
log file (sm.log).  

Error or informational messages that are 
generated in the log as the result of a 
timeout when performing a doSoapRequest 
now indicate that a timeout has occurred.  
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Global ID Problem Solution 

QCCR1E60543 Trying to update a column in a table of the 
type RAW(255) to any larger size fails with 
the following error message : 
 
An error occurred while attempting to 
update a record (record.update,start) 

 
 file:(dbdict) key:(name=slo) 
(record.update,start) 

 
 Changing SQL data type from 
'RAW(255)' to 'RAW(500)' for column 
'CONDITION' in table 'SLOM1' is not 
supported. Update cancelled. 
(record.update,start)  

For Oracle RDBMS, added support for 
widening the RAW data type to the 
maximum size (2000).  

QCCR1E62273 After removing a record from a To Do 
record list and then selecting a subsequent 
record, Service Manager (SM) displays a 
different record than the record selected.  

Service Manager refreshes the To Do queue 
correctly after closing a ticket from the To 
Do queue.  

QCCR1E62546 Querying the Incident REST WS returns 
an HTTP error 500 along with a stack trace 
if no Incidents are found that match the 
query.  

When querying the Incident REST WS and 
no entries are found which match the 
query, an empty list is returned to the 
caller.  

QCCR1E63830 When the user is searching for and viewing 
certain Knowledge Management (KM) 
documents, the system generates soap 
errors which disconnect the Service 
Manager client, and a WIN32 exception or 
a Signal 11 occurs in the server log.  

When the user is searching for and viewing 
KM documents, the WIN32 errors no 
longer occur.  

QCCR1E64802 With the following conditions in Service 
Manager: 

• There is a record, to which another 
record is linked via 
relatedObjectMap. 

• There is an inbox on the base record. 
This displays the primary key from 
the second table in the inbox for the 
first. 

• The primary keys of the two tables 
are named identically (for example, 
both are "id"). 

When you double-click a record in the inbox 
list and save it, the primary key of the first 
table is corrupted, so it contains the 
primary key of the second record.  

Fixed the code so that the table name is 
added as a prefix to the fields that are not 
coming from the first table. This will 
ensure that the primary key of the first 
table will not be corrupted.  
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Global ID Problem Solution 

QCCR1E64858 After deleting a record, the wrong 
interaction record displays after a user 
clicks a new record with a higher record ID.  

When deleting a record from a QBE list 
displayed by the Web client without record 
list turned on, the QBE list displays 
correctly after the delete. Clicking any 
record of that QBE list selects the correct 
record.  

QCCR1E65135 When a record from a search that involved 
adhocsql files is updated and the updated 
record does not match the filter criteria, 
the record is not removed from the search 
list.  

When a record from a search that involved 
adhocsql files is updated, the record is 
removed from the search results if it no 
longer matches the filter criteria.  

QCCR1E65314 When performing an approval delegation in 
Service Request Catalog (SRC), a Signal 11 
occurred due to calling JavaScript (JS) 
from a trigger.  

Calling JavaScript (JS) from a trigger no 
longer causes a Signal 11 error.  

QCCR1E65361 Fields in the generated "make-up" dbdict 
for ADHOC SQL sometimes have an 
identical index number.  

The index numbers are now different.  

QCCR1E65690 Need to improve debugdbquery:999 output 
to include information identifying specific 
records for FETCHes, INSERTs, UPDATEs 
and DELETEs, and include the return 
codes for all these operations.  

The debugdbquery:999 output now includes 
information identifying specific records for 
FETCHes, INSERTs, UPDATEs and 
DELETEs, and also includes the return 
codes for all these operations.  

QCCR1E65659 User servlets are crashing several times a 
week on a load-balanced system with three 
nodes.  

Re-factored the thread monitor mechanism.  

QCCR1E65694 The process of parsing the IR stop words 
file could not be traced, so tailoring it could 
lead to unexpected results.  

Service Manager now allows tracing of the 
tokenization process, including during read 
of the stop words file. Trace is enabled by 
the already existing ir_trace:801 
parameter.  

QCCR1E66003 When the Service Manager Server 
generates a huge XML document, it may 
run out of memory and does not catch this 
exception.  

The Service Manager Server now will catch 
the OutOfMemoryException, write the 
exception to the server log, and terminate 
the current client session. 
Note: Memory monitor thread must be 
disabled (by setting memorypollinterval:0 
in the sm.ini file) for this fix to work.  

QCCR1E66000 Servlet is unresponsive during load testing.  Fixed the hang problem when log rotating 
so that the servlet remains responsive 
during load testing.  

QCCR1E66209 Client will exit when user chooses the 
Tasks, Changes, or Configuration Items 
queue and double-clicks a record.  

Client operations will be no problem when 
user chooses the Tasks, Changes, or 
Configuration Items queue and double-
clicks a record.  
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QCCR1E66690 Automated Testing: JavaScript unit tests 
need to be able to handle signals 
encountered by the RTE.  

When signals are encountered by the RTE 
during automated testing, the exception 
that is produced by the JavaScript can be 
caught by the JavaScript unit test.  

QCCR1E66747 JavaScript system.functions._null causes 
memory leak in Service Manager.  

Initialized the members of 
LocalRootAddScope with the passed-in 
parameter, so that JavaScript 
system.functions do not leak memory.  

QCCR1E66852 In Linux and Solaris, signal 11 and core 
dumps might occur at start-up if the 
system resources were exhausted.  

In Linux and Solaris, if the system 
resources are exhausted, Service Manager 
process will not run into a signal 11.  

QCCR1E66855 RAD function fduplicate sometimes will 
return an invalid return value, even if it 
executes successfully when being called in 
JavaScript.  

Changed the behavior so that the RAD 
function fduplicate will not return an 
invalid return value when it executes 
successfully while being called in 
JavaScript.  

QCCR1E66886 A Javacore error occurs when uCMDB 
pushes data into Service Manager in multi-
thread mode.  

Changed the default value of the initial 
Java heap size to 192M. Service Manager 
will log a warning when the user provides a 
JVMOption heap size min or max greater 
than 512M.  
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Global ID Problem Solution 

QCCR1E67061 When using Service Manager in a non-
English language (for example, French), 
the inactivity message the user receives is 
not localized: 
Your inactive HP Service Manager 
session (UID# xxx) will be 
automatically disconnected in 

00:00:45. 

Code has been changed on the Service 
Manager server side so that the inactivity 
timer background process generates the 
message according to the user's login 
language (for example, French). 

NOTE: A System Administrator still needs 
to do the following for users to see the 
localized message. This is because the 
above message is missing in the out-of-box 
scmessage table (This issue might be fixed 
in a future application patch release).  

1 Open the scmessage table in Database 
Manager. 

2 Add two records for English and the 
target language to the table. 

For English: 

Language Code: en 

Class: scbase 

Message Number: 130 

Text: Your inactive HP Service 
Manager session (UID# %ld) will be 
automatically disconnected in %d 
minute(s) %d second(s).     

For the target language (for example, 
French): 

Language Code: fr 

Class: scbase 

Message Number: 130 

Text: Votre session (UID# %Id) 
inactive de HP Service Manager sera 
automatiquement déconnectée dans %d 
minute(s) %d seconde(s). 

QCCR1E67071 The Knowledge Management update 
process (KMUpdate) causes an unnecessary 
load on the Service Manager (SM) server 
with approximately 15,000 to 20,000 extra 
logins per day. This, in turn, creates a lot of 
load on the Oracle database, licensing 
module, horizontally-scaled cluster 
communication, and many more. 
The KMUpdate process should have a 
companion KMStatusListener background 
process (which starts automatically on an 
as-needed basis) and will update the status 
in SM without a need for a special web 
service servlet container.  

A new background process 
(KMStatusListener) has been implemented 
that replaces the web service listener and 
updates status and error knowledgebase 
records using JavaScript. 
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Global ID Problem Solution 

QCCR1E67101 Service Manager displays a stack trace 
after the "sm -version" command is run.  

Only the version information is displayed 
when the "sm -version" command is run.  

QCCR1E67121 When trying to modify the unique key of a 
table, the following error occurs and the 
indexes are not updated. 
 
Error: SQL State: 42S22-1911 Message: 
[Microsoft][ODBC SQL Server 
Driver][SQL Server]Column name 
'RECORD_KEY' does not exist in the 
target table.  

In this case, a full-table-copy will be 
performed.  

QCCR1E67300 In some horizontal scaling scenarios, new 
TRClient threads are launched while the 
parent process is being shut down.  

Service Manager processes now shut down 
cleanly. It no longer creates more TRClient 
threads while shutting down.  

QCCR1E67416 Using a JavaScript call in a conditional 
RAD expression on a decision panel causes 
an error message: "Assignment operator 
found while evaluating a condition!", even 
when the JavaScript call works properly.  

Using a JavaScript call in a conditional 
RAD expression on a decision panel will no 
longer cause an error message when the 
JavaScript call works properly.  

QCCR1E67848 The RAD select panel will always result in 
SELECT * issues against the RDBMS.  

The RAD select panel now provides a field 
that allows you to input the columns to be 
selected. (This is the RTE component of 
that support.)  

QCCR1E68200 The displayed data List was incorrect after 
using Customize Current View when 
adding a field.  
Here is an example scenario: 

1 Log in to Service Manager as a system 
administrator. 

2 On the To Do Queue page, select 
Interaction as Queue. 

3 Select All Open Interactions as View.  

4 Click the Count Records button. The 
number of records (for example, 198) is 
displayed. This is correct. 

5 From the More or More Actions menu, 
click Customize Current View. 

6 Click Fields and then add "Contact Full 
Name" to the List. 

7 Click Finish. 

Only 4 records are displayed. After 
clicking field "Contact Full Name", only 
2 records are displayed. This is 
incorrect. 

The displayed data List will be correct after 
the user adds a field to the list using the 
Customize Current View option. 
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Application updates  

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E67072 Improve the Knowledge Management update 
process (KMUpdate) performance by 
removing the companion web service 
servletcontainer and adding a companion 
KMStatusListener background process 
(which is started on demand without any 
administration).  

A new KMStatusListener process will 
start on demand without any 
administrative need and will update, 
delete, and insert documents into the 
relevant KM module tables. 

Important: To take advantage of this 
change, you must load 
QCCR1E67072_SM921P4.unl, available 
in the platform_unloads directory. 

Documentation changes  

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E65857 Incorrect vendor labeling of 
operating system SuSe Linux. 

Changed "Novel SuSE" to "Novell SUSE" in the 
Compatibility Matrix documents for Service Manager 
versions 9.20 and 9.21. 

The updated documents are available at: 
http://support.openview.hp.com/sc/support_matrices.jsp 

QCCR1E67029 The help topic "Configure LW-
SSO in Service Manager" does 
not state that the <webui> node 
should be enabled. 

When configuring LW-SSO in Service Manager 9.2x, 
users need to make an additional change in the web 
tier's lwssofmconf.xml: 

• For Service Manager 9.20, change <webui 
enabled=false> to <webui enabled=true>. 

• For Service Manager 9.21, change 
enableLWSSOFramework="false" to 
enableLWSSOFramework="true". 

For more information, see Additions to the 
Documentation. 

http://support.openview.hp.com/sc/support_matrices.jsp�
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Known Problems, Limitations, and Workarounds 

This software release has the following known issues. 

Global ID  Known Issue  Workaround  

QCCR1E66695 When the group value of a catalog line item 
is empty, the add dependency link is not 
displayed. 

No workaround available at this time. 
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Installation Notes 

Before using patch 9.21.216 Patch 4 and all subsequent patches, you must manually remove the files listed 
below. 

Remove the following files from the "\RUN\lib" directory:  

• saaj-impl-2.1.jar  

• saaj-api-2.1.jar 

• jgroups-all-2.5.0.jar 

Remove the following files from the "\RUN\lib\endorsed" directory:  

• xercesImpl-jaxp-1.3.2.jar 

• xalan-jaxp-1.3.2.jar 

• jaxp-api-1.3.2.jar 

• dom-jaxp-1.3.2.jar 

• sax-jaxp-1.3.2.jar 

Web Tier installation 

The Web Tier update consists of a compressed file, sm9.21.216-P4_Web_Tier.zip. The specific upgrade 
process depends on your particular Web application server, but follows the same steps as deploying a new 
installation. For more information, refer to the Service Manager Installation Guide. 

The upgrade does not automatically save your Web Tier customizations. To keep your changes, you must 
save your customized files and replace the new version of these files with your customized version. 

To install the Web Tier update: 

1 Back up your web.xml file, splash screen, style sheets, and any other customizations you made, including 
your webtier-9.21.war (.ear) file. 

2 Delete or uninstall the existing webtier-9.21.war (.ear) file. 

3 Deploy the new webtier-9.21.war (.ear) file by following the instructions in the Service Manager 
Installation Guide. 

4 Replace the new versions of any files you customized with your customized versions. 

5 Make any new customizations necessary for your deployment. 
Note: Be sure to set the securelogin and sslport parameters. 

6 Restart the Application server. 

Windows client installation 

The Windows client update consists of a compressed file, sm9.21.216-P4_Win_Client.zip, which 
contains setup.exe. 

To install the Windows client update: 

1 Stop the Service Manager Windows client. 



 22 

2 Uninstall the Service Manager Windows client. (Your connection and personalized settings are retained.) 

3 Run setup.exe and install the client by following the instructions in the Service Manager Installation 
guide and Release Notes for your version. 

4 Check the version in Help > About Service Manager Client.  
The client should be Release: 9.21.216. 

Server installation 

The server update for your operating system (OS) consists of a compressed file, sm9.21.216-P4_<OS>.zip  
(or .tar), which contains the Service Manager server files. These files add to or replace the files in the [SM 
Root]\ ([SM Root]/) RUN, irlang, legacyintegration, and platform_unloads directories. 

To install the Server update: 

1 Stop all Service Manager clients. 

2 Stop the Service Manager server. 

3 Make a backup of the RUN directory. 

4 Extract the compressed files for your operating system into the main Service Manager directory on the 
server. The default path is:  C:\Program Files\HP\Service Manager 9.21. 

5 For UNIX servers, set the file permissions for all Service Manager files to 755. 

6 Remove the following files from the "\RUN\lib" directory:  

• saaj-impl-2.1.jar 
• saaj-api-2.1.jar 
• jgroups-all-2.5.0.jar 

7 Remove the following files from the "\RUN\lib\endorsed" directory:  

• xercesImpl-jaxp-1.3.2.jar 
• xalan-jaxp-1.3.2.jar 
• jaxp-api-1.3.2.jar 
• dom-jaxp-1.3.2.jar 
• sax-jaxp-1.3.2.jar 

8 Restart the Service Manager server. 

9 Restart the Service Manager clients. 

10 Check the version in Help > About Service Manager Server.  
The server should be Release: 9.21.216. 
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Application unload installation 

The application consists of the unload files that come with the server updates. When you extract 
sm9.21.216-P4_<OS>.zip (or .tar), it will add the new files to your  
[SM Root]\platform_unloads ([SM Root]/platform_unloads) directory. 

Unload file naming convention 

The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where: 

• <CR_ID>: The identification number of the applications defect that the unload file fixes. For example, 
QCCR1E12345. Note that this is always the number of the parent CR of a CR family (if any). 

• SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example, 
SM921P2, which means the unload file comes with the server updates in Service Manager 9.21 patch 2 
and should be used for patch 2 or higher.  

Note: Sometimes this portion contains an additional hot fix number, for example, SM711P16HF8. This 
example means the unload file is intended for Service Manager 7.11 patch 16 Hot Fix 8 or higher.  

• SMxxx: The Service Manager applications version that requires the unload file. For example, SM711, 
which means the unload file is intended only for Service Manager applications version 7.11. 

Note: If this suffix is omitted, the unload file is then intended for all applications versions compatible 
with the server version. For example, for Service Manager server 9.21, the compatible applications 
versions are 7.11 and 9.20. 

New application updates in the current patch 

The following are new unload files introduced in the current patch release. 

• QCCR1E67610_SM921P4.unl, which enables you to block potentially dangerous attachments. For more 
information, see Blocking attachments with certain file extensions. 

• QCCR1E67072_SM921P4.unl, which enables you to improve the Knowledge Management update 
process (KMUpdate) performance. 

Application updates in previous patches 

Additional application updates have been included with this cumulative release. If you have not already 
applied them for a previous patch, you should also apply the unload files that are used for your applications 
version (see the following table). For more details about these applications updates, see the Release Notes for 
those patches, also included with the release. 

Unload file Comes 
from 9.21 
patch 

Used for 
applications 
version(s) 

Description 

QCCR1E55715_SM921p1.unl P1 7.11 and 9.20 Includes application changes to 
reduce database I/O on login. 
 

QCCR1E57767_SM921p1.unl P1 7.11 and 9.20 Includes application changes to 
reduce jgroups traffic on login. 
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Unload file Comes 
from 9.21 
patch 

Used for 
applications 
version(s) 

Description 

QCCR1E59753_SM921p2.unl P2 7.11 and 9.20 Includes application changes to 
fix the ToDo bar.  
 

QCCR1E31545_SM921P2_SM711.unl P2 7.11 Prevents backslashes included in 
a template from being duplicated 
in the output. 

Note:  This file is not required 
for Applications 7.00. 

QCCR1E31545_SM921P2_SM920.unl P2 9.20 Prevents backslashes included in 
a template from being duplicated 
in the output. 

QCCR1E49721_SM921P3_SM711.unl P3 7.11 Enables translation of 
Display/Value lists on dynamic 
forms. This is a required fix for 
the Export to Excel redesign. 

QCCR1E56678_SM921P3_SM711.unl P3 7.11 Lists the records in the right 
group order when a record list is 
refreshed. 

QCCR1E58562_SM921P3_SM711.unl P3 7.11 Includes applications changes for 
Export to Excel redesign. 

QCCR1E58562_SM921P3_SM920.unl P3 9.20 Includes applications changes for 
Export to Excel redesign. 

To load an unload file: 

1 Make sure the Windows client is configured for server-side load/unload.  

a) From the Windows client, go to Window > Preference > HP Service Manager.  

b) Unselect Client Side Load/Unload if is flagged.  

c) Restart the Windows client. 

2 Open Tailoring > Database Manager. 

3 Right-click the form or open the options menu and select Import/Load. 

4 Fill in the following fields. 

Field Description 

File Name Type the name and path of the file to load. 

Import Descriptor Since unload files do not require an Import Descriptor record, leave this field 
blank. 

File Type Select the source operating system of the unload file. 

Messages Option —  
All Messages 

Select this option to see all messages that Service Manager generates loading the 
file. 
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Field Description 

Messages Option —  
Totals Only 

Select this option to see only the total number of files Service Manager loads. 

Messages Option — 
None 

Select this option to hide all messages that Service Manager generates when 
loading the file. 

Note: You can view the contents of an unload file before importing it by clicking List Contents. 

5 Click Load FG.  
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Additions to the Documentation 

The following information supports updates included in this patch. 

• Deploy the Service Manager Web tier on WebSphere 6.1 

• Prepare array data for Web services integrations  

• Blocking attachments with certain file extensions 

• Special parameters: msglog 

• Configure LWSSO in Service Manager 

Deploy the Service Manager Web tier on WebSphere 6.1 

To deploy the web tier on WAS 6.1, perform the following steps.  

Note: The steps are slightly different for Solaris and other platforms (Windows, Linux, and AIX); the “x.xx” 
in the steps represents the Service Manager version, that is, 7.11. 

1 Copy or save the webtier-x.xx.ear file onto your local system.  

2 Update the webtier-x.xx.ear file by modifying the web.xml file contained in the webtier-x.xx.war file 
(which is packaged in the ear file). At a minimum, you need to set four parameters in the web.xml file: 
serverHost, serverPort, secureLogin, and sslPort.  

3 Re-archive the files in the ear file. Be sure to keep the original filenames and folder structure. 

4 Log on to the administration console of the WebSphere 6.1 Application Server with system privileges.  

5 Click Applications > Install New Application.  

6 Select Local file system and browse to your updated webtier-x.xx.ear file.  

7 Click Next. The file uploading starts. This may take quite a while. 

8 Click Next on each screen to accept the default settings until you reach the final step, and then click 
Finish. The installation of the web tier ear file begins. Wait until the installation completes.  

9 Click Save to save your configurations. 

10 Go to Enterprise Applications > HP Service Manager x.xx Web > Class loader, and make the following 
selections:  

- In the "Class loader order" section, select Classes loaded with application class loader first.  
- In the "WAR class loader policy" section, select Single class loader for application. 

11 Go to Enterprise Applications > HP Service Manager x.xx Web > Manage Modules > webtier-x.xx.war, 
and make the following selection: 

- In the "Class loader order" section, select Classes loaded with application class loader first.  

12 (For Solaris only) Add the javax.xml.transform.TransformerFactory system property to the JVM options:  

a Go to Application servers > server1 > Process Definition > Java Virtual Machine. 

b Add the following code to the "Generic JVM arguments" text box: -
Djavax.xml.transform.TransformerFactory=com.sun.org.apache.xalan.internal.xsltc.trax.T
ransformerFactoryImpl  

13 Click Save to save your local configuration changes. 
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14 Go to Enterprise Applications > HP Service Manager x.xx Web, and click Start to start the web tier 
application.  

15 When the application is successfully started, you can browse to the web tier login URL to launch the web 
client: http://<WAS_server_hostname>:<port>/webtier-x.xx/index.do 

Prepare array data for Web services integrations  

When integrating an application with Service Manager through Web services, array data should be broken 
into multi elements by separator "\r". This is because Service Manager uses "\r" as the separator between 
array elements. When a string that contains "\r" is retrieved from the Service Manager system, it is decoded 
as an array with multi elements separated by "\r". For this reason, when integrating other applications (for 
example, UCMDB) with Service Manager through web services, array data should be broken into multi 
elements by separator "\r" before the data is encoded and sent to the Service Manage system.  

For example, if an array contains elements "aabb" and "ccdd", it should be sent to Service Manager as the 
following: 

<ns:Comments type=\"Array\"> 

<ns:Comments mandatory=\"\" readonly=\"\">aabb</ns:Comments> 

<ns:Comments mandatory=\"\" readonly=\"\">ccdd</ns:Comments> 

</ns:Comments> 

Blocking attachments with certain file extensions 

To prevent potentially dangerous executable files from being submitted as attachments, Service Manager 
now provides support for blocking certain types of attachments submitted through the Windows and web 
clients, as well as through web services, based on a pre-defined list of blocked file extensions. At startup, the 
Windows and web clients retrieve the list of blocked file extensions, which is stored in the extensionstate 
table in the database. If no list is available, the clients use a default list. (For more information, see Default 
list of blocked file extensions.) 

To take advantage of this enhancement, you must install all of the following:  

• The Windows client update for this release (QCCR1E64285) 
• The Web Client update for this release (QCCR1E64278) 
• The server update for this release (QCCR1E64290), including the supporting application unload file, 

QCCR1E67610_SM921p4.unl.  

System Administrators can add, delete, and update records in the extensionstate table to customize the 
list of blocked file extensions. (For more information, see Customize the list of blocked file extensions.) 

If a search engine is installed and connected to the system, System Administrators must also update the 
sclib knowledgebase records, to include .unsafe to the list of file extensions that should be skipped for 
indexing. (For more information, see Add .unsafe to the list of file extensions to skip for knowledgebase 
indexing.) 

Important: When your customization is complete, you must restart the web tier's web application server 
(for example, Tomcat, WebSphere) or restart the Windows client for the changes to take effect. 

With these enhancements, Service Manager blocks the attachments in the following ways: 

• When users attempt to attach a file whose extension is in the list of blocked file extensions to a record, 
the clients disallow attaching the file and display the following error message: "File type: <filetype>, is 
not allowed as an attachment." 
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• If the clients retrieve an existing attachment whose extension is included in the list of blocked file 
extensions, the clients append ".UNSAFE" to the file name to prevent the file from being automatically 
'run' on the user's machine. 

• During web services processing, if a transaction submits or retrieves a file as an attachment whose 
extension is included in the list of blocked file extensions, the server appends ".UNSAFE" to the 
submitted or retrieved file name. 

Customize the list of blocked file extensions 

User Role: System Administrator 

You can add or remove files from the list of blocked file extensions based on the needs of your company. 

To view and customize the list of blocked file extensions: 

1 Open System Administration > Base System Configuration > Miscellaneous > File Extensions. 

2 Click Search.  
A list of file extension records displays. 

3 To add a new record: 

a Open an existing record. 

b Update the fields as follows: 

- File Extension: Type an extension without the dot character (.) For example, type "bat" rather 
than ".bat". 

- Unsafe: Check this box to block attachments with this file extension or uncheck this box to 
unblock them. 

- File Type: Type a description of this file type. 

c Click Add.  
The new file extension is added to the list. 

4 To update an existing record: 

a Select the record from the list. 

b Check or uncheck the Unsafe check box. 

c Click Save to save the record. 

5 To delete a record: 

a Select the record from the list. 

b Click Delete. 

c Click Yes to confirm the deletion.  
The record is removed from the list. 

6 Do the following for the changes to take effect: 

- Windows client: Log out and exit the client and then restart it. 
- Web client: Restart the web application server. 

Add .unsafe to the list of file extensions to skip for knowledgebase indexing 

User Role: System Administrator 

To prevent Service Manager from indexing unsafe attachments for knowledgebase searches, add .unsafe to 
the list of file extensions that should not be indexed or extracted. To do this, updating the following sclib 
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type knowledgebases: Incident_Library, Interaction_Library, Knowledge_Library, Knownerror_Library, and 
Problem_Library. 

Note: This task requires that you have a search engine installed and correctly configured. 

To update the knowledgebases: 

1 Open Knowledge Management > Configuration > Knowledgebases. 

2 Click Search. 
A list of records displays: Incident_Library, Interaction_Library, Knowledge_Library, 
Knownerror_Library, and Problem_Library. 

3 Select a record in the list, and open the Type information tab. 

4 In the Skip these extensions field, add .unsafe to the existing file extension list, using a semi-colon as 
the separator. For example, type: jpg;bmp;gif;exe;unl;unsafe. 

5 Click Save. 

6 For the other records in the record list, repeat steps 3 through 5. 

After you complete this, the files you indicated will be blocked from being submitted as attachments. 

Default list of block file extensions 

Service Manager blocks attachments whose file name extensions are included in a list of files retrieved from 
the database. If such a list is not available from the database, Service Manager blocks attachments with the 
file name extensions listed in the following table. 

File Name Extension Description  

.ade  Access Project Extension (Microsoft)  

.adp  Access Project (Microsoft)  

.app  Executable Application  

.asp  Active Server Page  

.bas  Active Server Page  

.bat  Batch Processing  

.cer  Internet Security Certificate File  

.chm  Compiled HTML Help  

.cmd  DOS CP/M Command File, Command File for Windows NT  

.com  Command  

.cpl  Windows Control Panel Extension (Microsoft)  

.crt  Certificate File  

.csh  csh Script  

.der DER Encoded X509 Certificate File 

.exe  Executable File  

.fxp  FoxPro Compiled Source (Microsoft)  

.gadget Windows Vista gadget 
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.hlp  Windows Help File  

.hta  Hypertext Application  

.inf  Hypertext Application  

.ins  IIS Internet Communications Settings (Microsoft)  

.isp  IIS Internet Service Provider Settings (Microsoft)  

.its  Internet Document Set, Internet Translation  

.js  JavaScript Source Code  

.jse  JScript Encoded Script File  

.ksh  UNIX Shell Script  

.lnk  Windows Shortcut File  

.mad  Access Module Shortcut (Microsoft)  

.maf  Access (Microsoft)  

.mag  Access Diagram Shortcut (Microsoft)  

.mam  Access Macro Shortcut (Microsoft)  

.maq  Access Query Shortcut (Microsoft)  

.mar  Access Report Shortcut (Microsoft)  

.mas  Access Stored Procedures (Microsoft)  

.mat  Access Table Shortcut (Microsoft)  

.mau  Media Attachment Unit 

.mav  Access View Shortcut (Microsoft)  

.maw  Access Data Access Page (Microsoft)  

.mda  Access Add-in (Microsoft), MDA Access 2 Workgroup (Microsoft)  

.mdb  Access Application (Microsoft), MDB Access Database (Microsoft)  

.mde  Access MDE Database File (Microsoft)  

.mdt  Access Add-in Data (Microsoft)  

.mdw  Access Workgroup Information (Microsoft)  

.mdz  Access Wizard Template (Microsoft)  

.msc  Microsoft Management Console Snap-in Control File (Microsoft)  

.msh Microsoft Shell  

.msh1 Microsoft Shell  

.msh2 Microsoft Shell  

.mshxml Microsoft Shell  

.msh1xml Microsoft Shell  

.msh2xml Microsoft Shell  
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.msi  Windows Installer File (Microsoft)  

.msp  Windows Installer Update 

.mst  Windows SDK Setup Transform Script  

.ops  Office Profile Settings File  

.pcd  Visual Test (Microsoft)  

.pif  Windows Program Information File (Microsoft)  

.plg Developer Studio Build Log 

.prf  Windows System File  

.prg  Program File  

.pst  MS Exchange Address Book File, Outlook Personal Folder File (Microsoft)  

.reg  Registration Information/Key for W95/98, Registry Data File  

.scf  Windows Explorer Command  

.scr  Windows Screen Saver  

.sct  Windows Script Component, Foxpro Screen (Microsoft)  

.shb  Windows Shortcut into a Document  

.shs  Shell Scrap Object File  

.ps1 Windows PowerShell 

.ps1xml Windows PowerShell 

.ps2 Windows PowerShell 

.ps2xml Windows PowerShell 

.psc1 Windows PowerShell 

.psc2 Windows PowerShell 

.tmp  Temporary File/Folder  

.url  Internet Location  

.vb  VBScript File or Any VisualBasic Source  

.vbe  VBScript Script File, Visual Basic for Applications Script  

.vbs  VBScript Script File, Visual Basic for Applications Script  

.vsmacros  Visual Studio .NET Binary-based Macro Project (Microsoft)  

.vsw  Visio Workspace File (Microsoft)  

.ws  Windows Script File  

.wsc  Windows Script Component  

.wsf  Windows Script File  

.wsh  Windows Script Host Settings File  

.xnk Exchange Public Folder Shortcut 
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Special parameters: msglog 

Parameter  

msglog  

Description  

This parameter defines the maximum number of messages the HP Service Manager server displays in 
the log file. These include only messages designated for the current operator. That is, the messages that 
are addressed to operator() or any field whose value equals operator(). 

Note: If not explicitly specified (either in sm.ini or in the server's OS command prompt), this parameter 
is disabled.  

Valid if set from  

Server's OS command prompt  

Initialization file (sm.ini)  

Requires restart of HP Service Manager server?  

No  

Default value  

50000  

Possible values  

Number of log messages to display  

Example usage  

Command line: sm -httpPort:13080 -msglog:75000  

Initialization file: msglog:75000 

Configure LW-SSO in Service Manager 

User role: System Administrator 

To configure LW-SSO in Service Manager: 

Note: The following procedure is provided as an example, assuming the Service Manager Web tier is 
deployed on Tomcat.  

1 Deploy the Service Manager Web tier on a Web application server (for example, Tomcat), and modify 
parameters such as the Service Manager server name and port in the web tier's web.xml if necessary.  

2 Modify the <tomcat_root>\conf\server.xml by adding tomcatAuthentication="false" to the following 
node:  

    <Connector port="8009"  

         enableLookups="false" tomcatAuthentication="false" redirectPort="8443" debug="0" 

         protocol="AJP/1.3" /> 

3 Modify <Service Manager Web tier>\WEB-INF\web.xml.  

a Change the value of context parameter isCustomAuthenticationUsed to false.  



 33 

b Remove the comment tags (<!-- and -->) enclosing the following elements to enable LW-SSO 
authentication.  

        <!-- 

           <filter> 

               <filter-name>LWSSO</filter-name> 

               <filter-class>com.hp.sw.bto.ast.security.lwsso.LWSSOFilter</filter-
class> 

           </filter> 

        --> 

       ...... 

        <!-- 

        <filter-mapping> 

            <filter-name>LWSSO</filter-name> 

            <url-pattern>/*</url-pattern> 

        </filter-mapping> 

        --> 

4 In the <Service Manager Web tier>\WEB-INF\classes\lwssofmconf.xml, do the following: 

a Enable LW-SSO: 

— For Service Manager 9.20, change <webui enabled=false> (default) to <webui enabled=true>. 

— For Service Manager 9.21, change enableLWSSOFramework="false" (default) to 
enableLWSSOFramework="true". 

b Modify the following parameters in the webui node.  

—  <domain>: Domain name of the server where you deploy your Service Manager Web tier. For 
example, if your Web tier's fully qualified domain name is mywebtier.domain.hp.com, then the domain 
portion is domain.hp.com.  

— initString: Password used to connect HP products (minimum length: 12 characters). For example, 
smintegrationlwsso. Make sure that this value is the same as those used in the LW-SSO configurations 
of the other HP products (such as Operations Orchestration, and Business Service Management), which 
you want to connect via LW-SSO.  

— <logoutURLs>: Add a sperate <url> element for your Service Manager Web tier: 
<url><webtier_name>/goodbye.jsp</url>. For example, if the Web tier name is webtier-9.20: 
<url>webtier-9.20/goodbye.jsp</url> 

       Note: This change is required only for Service Manager 9.20.  

— <protectedDomains>: Add a separate <url> element for each domain you want to support with LW-
SSO.  

Below is an example for Service Manager 9.20: 

        <webui enabled="true"> 

        ...... 

        <web-lwsso> 

               <lwsso startLWSSO="enabled">         

                   <domain>domain.hp.com</domain>                         

                  <crypto cipherType="symmetricBlockCipher" 

                  engineName="AES" paddingModeName="CBC" keySize="256" 

                  encodingMode="Base64Url" initString="smintegrationlwsso"></crypto> 
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                  <expirationPeriod>50</expirationPeriod> 

              </lwsso> 

        ...... 

              <logoutURLs> 

                  <url>webtier-920/goodbye.jsp</url> 

              </logoutURLs> 

              <protectedDomains> 

                  <url>domain1.hp.com</url> 

                  <url>domain2.hp.com</url> 

              </protectedDomains> 

        ...... 

        </webui> 

 The following is an example for Service Manager 9.21:  

         <enableLWSSO 

            enableLWSSOFramework="true" 

            enableCookieCreation="true" 

            cookieCreationType="LWSSO"/> 

 

        <webui> 

            <validation> 

                <in-ui-lwsso> 

                   <lwssoValidation id="ID000001"> 

                       <domain>domain.hp.com</domain> 

                       <crypto cipherType="symmetricBlockCipher" 

                       engineName="AES" paddingModeName="CBC" keySize="256" 

                       encodingMode="Base64Url" 

                       initString="smintegrationlwsso"/> 

                    </lwssoValidation> 

                </in-ui-lwsso> 

          ...... 

       

            </validation> 

     

         ...... 
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            <logoutURLs> 

                <url>.*/goodbye.jsp.*</url> 

                <url>.*/authFailure.jsp.*</url> 

            </logoutURLs> 

     

         ...... 

     

            <protectedDomains> 

                <url>domain1.hp.com</url> 

                <url>domain2.hp.com</url> 

            </protectedDomains> 

        </webui> 

5 Modify <Service Manager Web tier>\WEB-INF\classes\application-context.xml.  

a Add lwSsoFilter to filterChainProxy: 
/**=httpSessionContextIntegrationFilter,lwSsoFilter,anonymousProcessingFilter 

b Uncomment bean lwSsoFilter for HP Lightweight Single Sign-On: <bean id="lwSsoFilter" 
class="com.hp.ov.sm.client.webtier.lwsso.LwSsoPreAuthenticationFilter"> 

6 Restart Tomcat so that the configuration takes effect. 

Verified Environments 

The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software products, 
and other compatibility and support information.  

To access the Compatibility Matrix:  

1 Use a browser to navigate to the Software Support Online (SSO) web page:  
http://support.openview.hp.com/sc/support_matrices.jsp 

2 Log on with your Customer ID and password or your HP Passport sign-in.  

3 Navigate to the applicable information.  

Local Language Support 

UTF-8 is part of the Unicode standard, which enables you to encode text in practically any script and 
language. Service Manager 9.21 supports UTF-8 as an encoding method for new or existing data. It can 
support multiple languages that adhere to the Unicode standard on the same server. 

http://support.openview.hp.com/sc/support_matrices.jsp�
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Support 

You can visit the HP Software support web site at: 
www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.  

HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient 
way to access interactive technical support tools needed to manage your business. As a valued support 
customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 
http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 
http://h20229.www2.hp.com/passport-registration.html 

http://h20230.www2.hp.com/new_access_levels.jsp�
http://h20229.www2.hp.com/passport-registration.html�
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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notice 

© Copyright 1994-2011 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

• Adobe™ is a trademark of Adobe Systems Incorporated. 

• Java™ is a registered trademark of Oracle and/or its affiliates. 

• Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation. 

• Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California. 

• UNIX® is a registered trademark of The Open Group. 

For a complete list of open source and third party acknowledgements, visit the HP Software Support Online 
web site and search for the product manual called HP Service Manager Open Source and Third Party 
License Agreements. 
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